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PHẦN 1.  CÁCH TẠO BÀI THUYẾT TRÌNH ĐƠN GIẢN 

1.1. Làm quen nhanh với PowerPoint 2007 

1.1.1. Làm quen với giao diện mới (Ribbon) 

 Những phần thay đổi dễ nhận thấy nhất là khu vực phía trên của cửa sổ 

PowerPoint. Thay vì những menu và toolbar như trước đây thì người dùng 

PowerPoint 2007 sẽ thấy cách sắp xếp khoa học hơn với những lệnh liên quan 

được đưa vào một nhóm. Dãy lệnh trên cửa sổ PowerPoint 2007 được gọi là 

Ribbon, nó được xem là trung tâm điều khiển cho việc tạo ra các bài thuyết 

trình (Presentation) .  
 

 

 

 Ribbon bao gồm một số tab với chức năng cụ thể như sau: 

 Insert: Đây là nơi bạn có thể thêm vào slide những table, picture(hình 

ảnh), Chart(biểu đồ), clip art (thêm vào những đoạn text, âm thanh, 

hình vẽ-drawing,…), photo alblum (chọn hình nền cho slide), shapes,.. 

 Design: là nơi làm cho slide có hình thức đẹp hơn bao gồm cách thiết 

kế thông tin nền, font chữ và cách sắp xếp màu sắc. 

 Animations: Đây là tab tạo nên sinh khí cho bài thuyết trình. Bạn có 

thể dễ dàng sử dụng nhiều hiệu ứng cho bài thuyết trình trên tab này. 

 Slide Show: Khi bắt đầu thuyết trình thì chắc chắn rằng bạn phải sử 

dụng tab này và lựa chọn các mục sau đây cho bài trình chiếu của bạn. 

- From Beginning (F5): Nếu bạn muốn bắt đầu 1 bài thuyết trình 

- From Current Slide (Shift + F5): Khi muốn biễu diễn slide hiện 

hành. 

- Custom Slide Show: Chỉ biễu diễn những Slide mà bạn chọn. 
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- Set up Slide Show: Thiết lập những slide cần biễu diễn( vd: bạn 

muốn biễu diễn từ slide 1 Slide 5 của bài thuyết trình) 

- Record Narration: Bạn có thể thu âm lại toàn bộ bài thuyết 

trình của bạn. 

 

 Review: Với tab này bạn có thể kiểm tra chính tả đảm bảo an toàn cho 

bài thuyết trình. 

 View: Với Tab này bạn có thể xem lại bài thuyết trình và sắp xếp lại 

bài thuyết trình trên cửa sổ. 

1.1.2. Tìm hiểu về thư viện (Gallery) trong tab Amination 
 

 
 

 Một số hiệu ứng chuyển tiếp giữa các Slide (Slide Transition) trên Ribbon. 

 Để tìm thêm nhiều mẫu Slide Transition, chọn nút More. Toàn bộ thư viện 

Slide Transition được thể hiện trên màn hình, rê chuột vào các Transition để 

xem thử, click vào Transition phù hợp để áp dụng cho bài thuyết trình của 

mình. 

1.1.3. Các trình soạn thảo cơ bản được sử dụng trong quá trình soạn thảo 

powerpoint 

 Các Khung Outline, Slide notes, Slide  

 Trên màn hình sọan thảo còn có các thành phần sau  

 Cửa sổ Outline thể hiện cấu trúc tổ chức các khung slide trong phiên trình 

bày. Có thể dùng khung này để tạo và sắp xếp các slide.  

 Cửa sổ Notes cho phép bổ sung ghi chú trong mỗi trang thuyết trình. Khung 

Notes thường dùng để mô tả chi tiết cho nội dung khung slide.  
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 Cửa sổ Slide: nội dung cần trình bày nằm ở khung này. Khung Slide bao gồm 

văn bản, hình ảnh, các đoạn âm thanh mà chúng ta muốn trình diễn. Việc soạn  

thảo hầu hết tập trung ở phần này.  

 Khung Task (Task Panes): chứa các liên kết (link) đến các chức năng cơ bản 

thường sử dụng. Khung này được sử dụng rất nhiều trong   quá   trình   soạn   

thảo,   gồm   nhiều   khung:   New File / Presentation / Document, 

Clipboard, Search và Insert ClipArt. Để mở khung Task: View->Task Pane  
 

 

 Để di chuyển qua lại các khung này, chúng ta nhắp chuột vào khung hoặc nhấn 

F6.  

1.1.4. Khám phá những chức năng khác không hiện trên Ribbon 
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 Khi bạn không thấy một chức năng trong nhóm như nhóm Font như hình trên, 

thì hãy click vào mũi tên ở góc dưới của nhóm. Một hộp thoại xuất hiện với 

nhiều tùy chọn khác để bạn lựa chọn. 

 Thông thường có nhiều lệnh trong các nhóm, nhưng vì diện tích có giới hạn 

trên Ribbon, nên chỉ có những lệnh thường sử dụng nhất mới hiện trên màn 

hình, còn trong trường hợp không thấy bạn nên click vào các mũi tên trê 

Ribbon để tìm thêm những lệnh cần thiết. 

1.1.5. Sử dụng Quick Access Toolbar 

 Khi bạn làm việc với bài thuyết trình và có một vài tình huống bạn muốn lặp 

lại, chẳng hạn như lưu tài liệu, thì nên sử dụng Quick Access Toolbar. Nó là 

một nhóm nhỏ các nút lệnh nằm phía bên trái trên Ribbon. Các nút lệnh bao 

gồm Save, Undo, Repeat và Redo. 

 Bạn cũng có thể thêm các lệnh thường dùng vào Quick Access Toolbar bằng 

cách click phải chuột vào lệnh đó trên thanh Ribbon rồi chọn Add to Quick 

Access To. 

1.1.6.  Thay đổi góc nhìn cho bài thuyết trình 

 

 

 
1. Nút view giống như phiên bản trước đây, nhưng chúng bị thay 

đổi vị trí trên cửa sổ. 
 

2. Kéo thanh Zoom để phóng to thu nhỏ slide bài thuyết trình 

hoặc click nút cộng hoặc trừ có có tính năng phóng to hoặc thu nhỏ 

slide. 
3. Nhấn vào nút trong hình trên để chọn góc nhìn phù hợp. 
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1.1.7. Phím tắt của PowerPoint 2007 
 

 
 

 Nếu bạn thích sử dụng bàn phím hơn chuột, chắc chắn bạn cần phải biết phím 

tắt trong Office 2007. Cách thiết kế Ribbon đi kèm với cách sử dụng phím tắt 

mới. Có hai ưu điểm là có thể sử dụng một nút đơn cho phím tắt và sử dụng tổ 

hợp phím. Đây là cách sử dụng phím tắt. 

 Đầu tiên nhấn phím Alt trên bàn phím. 

 Những ký tự và con số xuất hiện trên hầu hết các trên phần của Ribbon 

được gọi là Key Tips, Những ký tự hiện trên các tab của Ribbon và nút 

Microsoft Office, còn những con số xuất hiện trên Quick Access 

Toolbar. Bây giờ bạn có thể sử dụng nó để có thêm nhiều lệnh và nút 

khác. Ví dụ nhấn nút “H” để hiện lên Key Tip cho tất cả các nhóm trên 

tab Home. 

 Sau đó nhấn Key Tip trong nhóm để thực hiện một lệnh nào đó, chẳng 

hạn bạn nhấn Alt, rồi H, rồi L thì bạn sẽ có lệnh layout cho bài thuyết 

trình. 

 Còn những phím tắt trước đây như thế nào? Nó vẫn được sử dụng bình thường 

với PowerPoint 2007. Chẳng hạn như phím tắt Ctrl + C là lệnh copy và phím 

tắt Ctrl + V là lệnh dán. 
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1.2. Các thao tác cơ bản 
 

 

Tìm hiểu bằng cách nào để thêm những slides mới, chọn một layout cho slide 

và sau đó thêm nội dung vào. Bạn cũng có thể sử dụng lại các slide từ bài 

thuyết trình khác và cuối cùng tìm hiểu bằng cách nào để chuẩn bị những ghi 

chú cho bài thuyết trình. 

1.2.1. Tìm hiểu về workspace (không gian làm việc) 
 

 
 

Hình ảnh trên được gọi là Normal View, khi bạn mở PowerPoint, thì bạn sẽ 

thấy Normal View của bài thuyết trình. Bạn làm việc ở đây để tạo ra các slide, 

có ba khu vực chính của Normal View: 

 Slide pane là khu vực lớn ở giữa, bạn sẽ làm việc chủ yếu tại đây. 

 Trên slide, những hộp được tạo thành bởi những chấm đứt quãng được 

gọi là placeholders. Chính nơi này bạn nhập dữ liệu, hình ảnh, biểu 

đồ và những thứ khác như file âm thanh, video clip. 

 Những hộp nhỏ phía bên trái gọi là thumbnail, khu vực này được gọi 

là tab Slide và bạn có thể chọn slide thumbnails (hình thu nhỏ của các 
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slide) ở đây để tìm và di chuyển tới các slide khác. 

 Khu vực phía bên dưới là notes pane, nơi bạn có thể nhập những ghi 

chú khi cần thiết. 

1.2.2. Làm việc với Slide 

Các chế độ View của Powerpoint: Trong phần này, chúng ta sẽ xem xét các 

khung nhìn khác nhau của một trình diễn trong quá trình soạn thảo. 

PowerPoint có thể hiển thị trình chiếu của chúng ta với nhiều cách khác nhau:   

Normal view,   Slide Sorter view,   Slide Show, Notes Page. Mỗi cách thiết kế 

để thực hiện các nhiệm vụ khác nhau tùy theo yêu cầu.  

 Để chuyển qua giữa các chế độ view: chọn View tab, hoặc chọn view buttons 

ở bên phải phía dưới của màn hình  

 Normal View: chế độ mặc định, cho phép xem và soạn thảo tất cả 

thành phần chính của slide với danh sách các trang của file. Để chọn 

slide, chúng ta chọn slide cần nhảy đến trong danh sách. Trong kiểu 

xem này, ta có thể làm việc với văn bản, các hình ảnh, biểu đồcho từng 

slide một. Ở chế độ này chúng ta có thể sọan thảo slide với sư trợ giúp 

của Slides pane hay Outline Pane.  
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 Slide Sorter View: với kiểu xem này, ta có thể dời, chép, xóa các 

slide, nhưng không thể hiệu chỉnh văn bản trong khung slide hoặc làm 

việc với các đối tượng slide. Kiểu này cho một cái nhìn tổng thể về 

toàn bộ file và thường được dùng khi cần sắp xếp thứ tự các trang. 

 

 
 Slide show: xem kết quả cuối cùng của các slide khi đã hoàn thành  

 Notes Page: cung cấp một khung ghi chú cho các slide. Loại này 

chuyên dùng khi chỉ làm việc với các ghi chú  

Để chuyển giữa các chế độ view, có thể sử dụng các nút lệnh (xem hình) hoặc 

từ menu: chọn menu: View->Normal (hay Slide Sorter, Slide Show…)  
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 Di chuyển giữa các slide: 

Để di chuyển giữa các slide, có nhiều cách làm: Bấm phím Page Up, Page 

Down để di chuyển  

 Click chọn slide ở thẻ Outline tab . 

 Chúng ta có thể di chuyển giữa các slide trong các cách xem (view) 

khác nhau.  

 Phóng to – thu nhỏ slide: 

- Chúng ta có thể sử dụng lệnh Zoom để thay đổi cách nhìn một 

slide to hay nhỏ hơn. Lệnh Zoom dựa trên độ phóng tính theo 

phần trăm.  

- Cách dễ nhất để zoom slide là kéo Zoom slider trong thang tác 

vụ nằm ở bên phải, phía dưới màn hình.  
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 Chọn nhiều slide đồng thời: 
 

 Để chọn nhiều slide đồng thời, chúng ta có thể sử dụng chế độ xem 

Slide Sorter view, sau đó chọn một hay nhiều slide bằng phím Ctrl 

hay phím Shift.  

 Hoặc chúng ta có thể chọn nhiều slide đồng thời từ của sổ Outline hay 

Slides. 
 

 Thêm hoặc xóa slide: 
 

 Để thêm 1 slide mới: Chọn Home-> Slides->New Slide. Hoặc chúng 

ta có thể bấm phím tắt Ctrl+M.  

 Để xóa một hay nhiều slide: chọn các slide này từ cửa sổ Outline -> 

bấm delete. 
 

 Nhập liệu nội dung vào slide: 

Có nhiều cách nhập dữ liệu vào slide.  

 Chúng ta nhập dữ liệu trực tiếp vào textbox trong Slide  

 Chúng ta nhập dữ liệu trực tiếp vào Outline Pane. 

 Sử dụng outline pane để nhập nội dung: 
 

 Chuyển đến Outline view: click vào thẻ Outline tab.  

 Để thụt hàng vào cho các hàng, sử dụng phím Tab.   Ngược lại, sử 

dụng phím Shift + Tab .  

 Để di chuyển các đoạn văn hay nội dung: chọn đoạn cần di chuyển, 

bấm phím phải chuột-> chọn Move Up hay Move Down  

1.2.3. Thêm slide mới vào bài thuyết trình 
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Khi mở PowerPoint ra chỉ có một slide trên màn hình bạn muốn thêm các slide 

khác thì cách thông dụng là chọn New Slide, trên tab Home tab, như hình trên. 

Có hai cách để sử dụng nút này. 

 Nếu bạn click phần trên của nút này, một slide mới sẽ xuất hiện ngay 

lập tức, bên dưới tab Slide, slide đó cũng xuất hiện. 

 Nếu bạn click phần dưới của nút này, bạn sẽ có một thư viện layouts 

cho slide để bạn có thể chọn lựa để thêm vào bài thuyết trình. 

1.2.4. Chọn kiểu dàn trang (layout) cho slide 

 

 
 

 Slide tiêu đề (Title Slide) trong hình trên có thể tìm kiếm trong Layouts 

Gallery. Thường trong Slide tiêu đề sẽ ghi tên bài thuyết trình và các thông tin 

liên quan như tác giả v.v... 
 

 Layout của Slide tiêu đề (Title Slide) bao gồm điểm định sẵn (placeholder) 

cho tiêu đề chính và tiêu đề phụ. 

 Layout bạn sẽ sử dụng cho hầu hết các slide khác được gọi là Title and 

Content (tiêu đề và nội dung), bạn có thể thấy trong Layouts Gallery. 

 Trên layout của các slide này có một placeholder cho tiêu đề và một 

placeholder cho việc nhập nội dung văn bản (text), hình ảnh (picture), phim 

ảnh (movie), biểu đồ (chart), … 
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1.2.5. Nhập nội dung văn bản vào slide 
 

 

 

 Bạn có thể sử dụng nhiều cấp khác nhau để thể hiện các nội dung chính và các 

nội dung phụ tương ứng 

 Trên Ribbon, sử dụng lệnh trong nhóm Font để có thể thay đổi cách định dạng 

cho các ký tự, màu sắc và kích cỡ chữ. 

 Sử dụng lệnh trong nhóm Paragraph để thay đổi định dạng các đoạn text như 

định dạng danh sách, xuống dòng. 

1.2.6. Chèn slide từ một bài thuyết trình khác 

 

 
 

Bạn có thể sử dụng những slide từ bài thuyết trình khác, cách làm như sau: 
 

 

 Trên tab Home, click mũi tên trên New Slide, Nếu bạn muốn chèn một slide 

mới thì chọn layout cho nó trước. 

 Phía dưới layout gallery, chọn Reuse Slides. 
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 Trong Reuse Slides, dưới Insert slide from, chọn Browse để tìm bài thuyết 

trình có những slide bạn muốn chèn và sau đó nhấp vào mũi tên để mở những 

slide này. 

 Khi đã có những slide bạn cần, chọn Keep source formatting bên dưới cửa 

sổ. Nếu bạn muốn giữ nguyên slide thì trước khi chèn bạn cần chọn  Keep 

source formatting. Nếu không chọn thì nó có định dạng giống như slide bạn 

đang làm việc. 

 Chọn slide bạn muốn chèn. Các slide sẽ được copy sang bài thuyết trình mà 

bạn đang làm. 

1.2.7.  Tạo ra những ghi chú cho người thuyết trình (speaker notes) 

 

 
 

 Khi xây dựng nội dung cho slide, bạn có thể nhập những ghi chú trong ô Notes 

phía bên dưới slide. 

 Bạn có thể nới rộng ô notes để dễ dàng làm việc bằng cách kéo thanh chia 

tách(Split bar). 

 Những ghi chú của bạn sẽ được lưu trữ trong một trang ghi chú bao gồm bản 

sao của slide với những ghi chú.
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1.3. Định dạng slide 

1.3.1. Sử dụng slide Master: 

 PowerPoint cung cấp cho chúng ta nhiều mẫu chuyên nghiệp dựng sẵn, với các 

màu sắc, cỡ chữ, font chữ, thiết kế đã được tính toán hoàn hảo.Tuy vậy, đôi khi 

chúng ta cần tạo một slide theo định dạng riêng của chúng ta. Việc này được 

thực hiện thông qua Slide Master.  

 Slide Master không phải là một slide, nhưng nó giống một slide. Nó là một 

mẫu chuẩn dạng lưới, dùng để tạo mẫu cho tất cả slide trong file trình diễn. 

Khi chúng ta thay đổi Slide Master, tất cả các slide của file PowerPoint sẽ 

được cập nhật theo.  

 Để mở Slide Master: chọn View-> Slide Master 

 

 

 Sau khi định dạng xong Slide Master, chúng ta phải đóng nó lại bằng nút Close 

Master View.  
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1.3.2. Chọn lại theme 

 Chúng ta có thể thiết lập lại theme khác có sẵn vào một hay nhiều slie trong fie 

trình diễn của mình. Để chọn lại một thems: Chọn một hay nhiều slide trong 

file trình diễn. 

 Chọn menu Design->từ Themes group, bấm phải chuột vào theme bạn muốn 

đổi để hiển thị shortcut menu  

 Chọn mục : Apply to All Slides: nếu muốn thay đổi tòan bộ slide.  

 Chọn mục: Apply to Selected Slides: nếu muốn thay đổi những slide 

đang chọn 
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  
 

1.3.3. Sử dụng theme color: 

 Nếu chúng ta muốn giữa nguyên các thiết kế, và chỉ thay đổi màu sắc, chúng ta 

có thể chọn các mẫu định dạng màu từ color scheme.  

 Để thay đổi màu sắc của file trình diễn:  

 Chọn menu Design ->Themes ->Colors.  

 Click chọn Color Schemes từ danh sách hiển thị  

1.3.4. Thay đổi màu nền: 

 Việc thay đổi màu nền là khá quan trọng, bởi nó cần phải hợp với màu chữ. Để 

thay đổi màu nền của một hay nhiều slide:  

 Chọn menu Design ->Background Style, hộp thoại Background hiển thị (xem 

hình)  
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 Chọn  màu  từ  danh  sách thả  xuống, nhấn chuột phải vào màu muốn chọn và 

và  bấm  nút Apply to All Slides.  
 

 

 Chúng ta có thể tùy biến nền bằng cách chọn mục BackGround Styles 
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1.3.5. Textbox: 

 Định dạng textbox: 

 Một trong các thành phần cơ bản quan trọng khi xây dựng slide là các 

textbox. Textbox dùng để nhập nội dung văn bản cần trình bày. Một 

slide được cấu thành từ một hay nhiều textbox. Do đó, việc định đạng 

textbox chính là công việc thực hiện nhiều nhất khi định dạng slide.  

 Tạo textbox:  

- Chuyển đến chế độ Normal view (chọn menuView, Normal). 

- Chọn menu Insert -> Textbox  

- Click trên slide, một  hộp text box sẽ hiển thị  

  

 
- Nhập nội dung vào text box, bấm Enter nếu muốn xuống hàng - 

tạo một đoạn văn khác. Khi muốn kết thúc, bấm vào bất cữ chỗ 

nào trên slide bên ngoài textbox.  
 

 Để xóa một textbox: chọn textbox đó, và bấm phím delete. 

 Thay đổi thiết lập về font 

 Để thay đổi font của một textbox hay văn bản bên trong textbox, chúng 

ta chọn menu Home tab-> chọn menu Font từ Font group. 
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 Ngoài ra, trong mục Font group cũng cho phép chúng ta chọn Font 

Style, font size, và các hiệu ứng Bold, Italic…(tương tự các định dạng 

của MS Word), màu sắc của chữ (color)…  
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1.3.6. Gióng hàng văn bản và các thiết lập khác: 

 Tương tự MS Word, để gióng hàng văn bản, chúng ta sử dụng menu Home -> 

chọn Paragraph group, và chọn nút lệnh trên thanh công cụ 

 

 

 

 

 

 

 

 

 

            

 

 

 Chúng ta có thể sử dụng các format khác cho textbox như: các định dạng về   

shape trong thẻ Drawing Tools -> Format, hoặc các hiệu ứng về text trong 

mục Font của thẻ Home -> Font, hoặc chọn Quick Styles, hoặc bấm phải 

chuột trên Textbox -> chọn Format Shape. 

 Tạo Bulleted List - danh sách đánh số (Numbered Lists) cho Textbox : 

 Chúng ta có thể bật - tắt chức năng đánh Bulleted List 

 Numbered List bằng nút lệnh Bullets - Numbering Paragraph group 

từ menu Home  
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1.3.7. Đối tượng shape 

Để vẽ thêm đối tượng shape hay line: chọn Insert ->Illustrations -> Shape 

 

 

 

 

 

 

 

 

 

 

 

1.3.8. Sử dụng Header và Footer 

 Headers và footers chứa các nội dung hiển thị ở đầu hay cuối mỗi trang như: 

tên báo cáo, người báo cáo, số trang…  

 Headers và footers được sọan thảo từ Slide Master, hoặc bằng cách thêm 

Header - footer. Để thêm Header và Footer:  

 Chọn một hay nhiều Slide muốn thêm Header và Footer  

Từ menu Insert -> chọn group Text -> Header & Footer  

 Nhập  thông  tin  vào  Header -  Footer  tùy  theo  chế  độ  Slide  hay 

Handouts 
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1.3.9. Các mẫu thiết kế theo chủ đề (Themes) 

 

 Mỗi bài thuyết trình có một chủ đề. Chủ đề xác định phong cách và màu sắc 

cho slide của bạn. Trên hình là ba kiểu slide có cùng một nội dung, nhưng với 

ba chủ đề khác nhau. Một chủ đề bao gồm: 

 Thiết kế nền 

 Màu sắc 

 Kiểu và kích cỡ font chữ 

 Vị trí các Placeholder (điểm định sẵn) 

 Chủ đề màu sắc ảnh hưởng đến màu hình nền, màu font chữ, màu đường viền 

và những yếu tố khác như bảng biểu và biểu đồ. 

1.3.10.   Các mẫu thiết kế theo chủ đề (Themes) 
 

 

 Mỗi bài thuyết trình mới bắt đầu với một chủ đề mặc định mà nó được gọi là 

Office Theme (chủ đề văn phòng). Cách chọn một chủ đề bằng cách nhấn vào 

tab Design và tìm một chủ đề cho bài thuyết trình của mình. 
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 Chủ đề mẫu bạn thấy sẽ nằm trong nhóm Themes. 

 Để tìm thêm chủ đề, click nút More mũi tên bên phải của nhóm Themes. 

 Khi chỉ con trỏ vào bất cứ chủ đề mẫu nào, bạn sẽ thấy nó hiện chủ đề đó lên 

slide 

1.4. Bảng biểu 

Tùy thuộc vào loại slide, chúng ta cần sắp xếp nội dung trên mỗi slide theo 

nhiều cột, hoặc ở các vị trí khác nhau trên slide. Khi tạo slide mới, PowerPoint 

2007 cho phép chúng ta chọn  slide  layout như sau:  

 Tạo slide mới (không click lên bất cứ đối tượng nào trên slide)  

 Chọn Home -> Slides ->Layout  

 Chọn loại layout thích hợp.  

 

 
 



  

                Tài liệu MS PowerPoint 2007 
 
 
 

 

Trang 28 

1.4.1. Tạo bảng: 

 Bảng (Table) được sử dụng để đặt các nội dung vào dưới dạng hàng -cột. Để 

tạo một bảng trên slide:  

 Từ  Insert -> Tables -> Table.  

 Rê chuột để chọn số hàng - cột và click chuột để tạo table.  

 

 

 Sau khi đã tạo xong bảng, để hiệu chỉnh Table, khi chúng ta chọn table, 

PowerPoint 2007 sẽ tự động hiển thị thẻ Table Tools với các lệnh cho phép 

chúng ta tùy chỉnh. Việc tùy chỉnh table thực hiện tương tự như trong MS 

Word 2007.  

1.4.2. Đưa WordArt vào Slide: 

WordArt dùng để tạo các hiệu ứng hình ảnh trên các nội dung text nhập vào. 

Điểm mới của PowerPoint 2007 là không có sự khác biệt giữa WordArt và các 

textbox: chúng ta chỉ việc áp dụng WordArt Styles vào các textbox. Để đưa 

WordArt Styles vào PowerPoint 2007: Chọn Insert ->Text group->WordArt. 

Chọn loại Wordart và nhập nội dung vào textbox mới hiển thị. Hoặc chúng ta 

thiết lập một textbox với wordart styles như sau:  

 Chọn nội dung text cần định dạng.  

 Từ  thẻ  Drawing  Tools  Format, trong WordArt Styles group, chọn 

thư viện WordArt Styles. Nếu chọn  Quick Style, chúng ta chú ý sẽ 
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có 2 nhóm khác nhau Chúng ta có thể hiệu chỉnh lại các tùy chọn cho 

Wordart sau này.  

1.5. Hình ảnh 

1.5.1. Cách chèn hình ảnh hoặc những thành phần khác 
 

 
 

 

 Chọn biểu tượng Clip Art trong placeholder. 

 Một cửa sổ nhiệm vụ Clip Art mở ra, nhập từ khóa trong hộp Search for với 

những chủ đề gợi ý phân loại, sau đó nhấn Go. 

 Những đoạn clip xuất hiện phù hợp theo yêu cầu của từ khóa. Chọn một cái để 

chèn vào trong slide. 

 Hình ảnh sẽ tự động có kích thước và vị trí trong placeholder. Bạn cũng có thể 

chèn bảng biểu, biểu đồ, hình ảnh cá nhân, video và SmartArt graphics bằng 

cách này. Nên lưu ý rằng bạn phải giảm dung lượng hình ảnh cần thiết khi 

chèn vào slide. 
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1.5.2. Cách chèn hình ảnh hoặc những thành phần khác bằng Tab Insert 

 Có một cách khác để chèn những thành phần khác vào slide bằng cách sử dụng 

tab Insert trên Ribbon. Tất cả mọi thứ bạn có thể chèn từ đây 

 

 
 

 Text boxes rất thuận tiện khi bạn muốn thêm đoạn text nơi nào đó và cần chú 

thích cho nó. Trước hết chọn Text Box trên tab Insert. 

 Và sau đó vẽ một hộp trên slide và nhập nội dung. 

1.6. Chỉnh sửa slide 

Khi chèn một hình ảnh vào rồi và bạn muốn điều chỉnh nó như chỉnh sửa kích 

thước, cắt bớt, chỉnh màu sắc, Sử dụng Picture Tools để làm việc này. Nó có 

sẵn khi bạn chọn hình ảnh. 
 

 

 Chọn hình ảnh. 

 Picture Tools xuất hiện trên Ribbon. Sử dụng lựa chọn trên tab Format để 

chỉnh sửa hình ảnh. 
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1.7. Sắp xếp nội dung slide 
 

 Khi bạn đã có nội dung cần thiết cho slide và bạn chỉ muốn sắp xếp chúng 

ngăn nắp hơn để làm cho bài thuyết trình ấn tượng hơn. Bạn có thể sử dụng 

lệnh Arrange để điều chỉnh các yếu tố. 

 

 

 

 Để sắp xếp thẳng hàng ghi chú với hình ảnh thì chọn placeholder của cả hai 

bằng cách nhấn Ctrl rồi chọn từng cái. 

 Tìm nhóm Arrange trên tab Format, trong Picture Tools. 

 Chọn nút Align và sau đó chọn Align Left. 

 Lệnh Arrange có sẵn trên nhóm Drawing, tab Home. 
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PHẦN 2.  CÁCH SỬ DỤNG BIỂU ĐỒ, ĐỒ THỊ VÀ BẢNG BIỂU 

2.1. Sử dụng hiệu ứng đồ họa với SmartArt 

2.1.1. Tạo đồ họa SmartArt 

Có hai cách để tạo đồ họa SmartArt: Cách thứ nhất là chuyển đổi nội dung có 

sẵn và cách thứ hai là chèn thành phần đồ họa trước rồi thêm thông tin vào. 

Sau đó học cách sử dụng thêm hình dạng cho nội dung text bằng cách dùng 

Text pane. Di chuyển hình dạng text bất cứ vị trí nào. 
 

 

 
 

 

 Chuyển đổi list (nội dung đã được chia) thành slide đồ họa 

 Bạn có thể chuyển đổi một slide list thành slide đồ họa SmartArt bằng cách 

chọn Convert to SmartArt Graphic trên Ribbon và chọn một trong 

những layout trong thư viện. Nếu bạn vẫn chưa tìm thấy cái nào vừa ý thì chọn 

More SmartArt Graphics phía dưới của thư viện SmartArt. 

2.1.2. Blank Graphic: Phương pháp thứ nhất 
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Khi bạn muốn làm việc với đồ họa thì bạn phải nhập nội dung trên slide, mở 

thư viện đồ họa SmartArt và chọn một mẫu thích hợp. Dưới đây là những bước 

thực hiện: 

 Trên tab Insert, nhấp SmartArt. 

 Chọn kiểu đồ họa bạn cảm thấy hài lòng. 

2.1.3. Blank Graphic: Phương pháp thứ hai 

Cách thứ hai là chèn thành phần đồ họa trước rồi thêm thông tin vào.  
 

 
 

Mỗi đối tượng đồ họa SmartArt có một cửa sổ văn bản để bạn có thể thêm text 

hoặc không tùy ý. Cửa sổ Text này dùng để nhập dữ liệu cho đồ họa và biên 

tập lại đồ họa. Bạn cũng có thể làm việc trực tiếp với đồ họa. 

 Ô cửa sổ Text nằm ở vị trí sát bên slide đồ họa. 

 Nhập dữ liệu vào cửa sổ này. 

 Nội dung text xuất hện tự động trong slide đồ họa. 

 Chú ý rằng đồ họa luôn xuất hiện với mặc định có text đi kèm. 
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2.1.4. Cách thể hiện nội dung văn bản (text) vào các hình đồ họa 
 

 
 

 Kiểu Layout của SmartArt mà bạn chọn quyết định cách mà văn bản thể hiện 

trong các hình đồ họa. Hình minh họa trên cho thấy văn bản được thể hiện 

khác nhau trong các layout khác nhau. 

 

 
 

 Muốn sử thử một layout cho slide? Bạn có thể dễ dàng chuyển sang cái layout 

khác bằng cách: 

 Chọn thành phần đồ họa trên slide, click tab Design trong SmartArt 

Tools. 

 Chọn một kiểu layout trong nhóm Layouts. 

 Kiểu layout đó sẽ được áp dụng với slide đồ họa. 
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2.2. Tạo trình diễn chuyên nghiệp với slide đồ họa 

 Bây giờ bạn có thể khám phá thế giới thiết kế có sẵn trong đồ họa SmartArt. 

Sử dụng thư viện đồ họa, màu sắc làm cho slide đồ họa chuyên nghiệp và đẹp 

đẽ hơn. Các Theme (chủ đề) tác động như thế nào đến thiết kế đồ họa của bạn. 

Các kiểu (style) và màu sắc tồn tại dưới hình thức các đường nét và văn bản 

trong các thành phần đồ họa. Các kiểu đổ bóng và phát sáng (glow) có thể làm 

cho slide đồ họa trở nên nổi bật. 
 

 

 

 Cuối cùng học cách làm việc với đồ thị bạn đã có trong bài thuyết trình cũ và 

bạn muốn nâng cấp chúng giống như đồ họa SmartArt hoặc bạn muốn giữ 

nguyên. Hãy đưa ra ý tưởng cho việc bạn chọn lựa và bạn mong muốn. 

2.2.2. Chủ đề bài thuyết trình: kiến thức căn bản về mẫu slide 
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 Trước khi làm việc với các mẫu và màu sắc đặc biệt cho đồ họa SmartArt, thì 

cần phải tìm hiểu thêm về Theme. Một theme cung cấp thiết kế cho toàn bộ 

bài thuyết trình và theme là nền tảng cho slide và phong cách (style) của slide. 

1. Slide đầu tiên áp dụng theme căn bản của PowerPoint được gọi là Office 

Theme. Đây là theme đơn giản nhất và nó được chọn mặc định. 
 

2. Slide thứ hai giống nội dung như slide thứ nhất, nhưng theme thì 

khác nhau, nó được gọi là Module. 

 Như bạn thấy trong hình trên, đồ họa trông rất khác nhau bởi vì theme khác 

nhau. Theme xác định thiết kế hình nền, màu sắc slide, layout của placeholder, 

vị trí văn bản và kiểu chữ. 

2.2.3. Mẫu SmartArt: Ví dụ 1 
 

 Giống như một bài thuyết trình có nhiều theme để lựa chọn, mỗi layout cho đồ 

họa SmartArt cũng có chứa nhiều mẫu (style) khác nhau. 

 

 

 Khi chèn một thành phần đồ họa vào nó sẽ được áp một mẫu mặc định, tuy 

nhiên bạn hoàn toàn có thể chọn một mẫu khác tùy ý. Ví dụ, hình trên cũng là 

đồ họa kiểu Office theme, nhưng nó lại ứng dụng mẫu khác, mẫu mặc định gọi 

là Simply Fill, còn bây giờ nó đã được thay thế bằng mẫu Intense Effect. Mẫu 

mới này có màu căn bản của theme mặc định, nhưng nó lại có hình dạng nổi, 

có hình phản chiếu và rõ nét hơn. 
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2.2.4. Mẫu SmartArt: Ví dụ 2 

 

 
 

 

 Trong ví dụ này một trong mẫu 3-D được ứng dụng gọi là Cartoon. Nó làm 

cho hình dạng trông có vẻ được nâng ra khỏi slide một chút. Hình dạng chính 

có góc cạnh và nổi bật từ đầu đến đáy. 
 

2.2.5. Thay đổi màu sắc cho mẫu (style) 

 Giống như một bài thuyết trình có nhiều theme để lựa chọn, mỗi layout cho đồ 

họa SmartArt cũng có chứa nhiều mẫu (style) khác nhau. 
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 Bạn có thể thay đổi màu sắc cho slide bằng cách sử dụng thư viện như hình 

trên. Thư viện  nằm  trên  tab  Design  tab  với  SmartArt  Tools  trên  

Ribbon,  trong  nhóm SmartArt Styles. Để thay đổi màu sắc cho mẫu, làm 

như sau: 

 Chọn Change Colors. 

 Chỉ vào bất cứ mẫu màu sắc nào. 

 Nhìn phần xem lại trên đồ họa, chọn một mẫu để ứng dụng màu sắc đó. 

 

2.2.6. Tìm hiểu thêm về shape (hình dạng) 

 

 
 

 Mẫu bạn ứng dụng đồ họa trông có vẻ tuyệt vời, nhưng bạn có thể làm hơn thế 

bằng cách sử tác động lên từng shape (hình dạng) riêng lẻ. Bạn có thể làm điều 

này trên tab Format với SmartArt Tools. 

 Chọn một hay nhiều shape (hình dạng) bạn thích. 

 Trên tab Format, nhìn vào nhóm Shape Styles để chọn Shape Effects 

và nhấn vào mũi tên. 

 Chọn các hiệu ứng, chẳng hạn như Shadow (đổ bóng). 
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2.2.7. Tìm hiểu thêm về mẫu cho văn bản (text style) 

 

 
 

 Bạn cũng có thể hệu chỉnh nội dung text trong đồ họa SmartArt. Để định dạng 

WordArt với nội dung text, làm như sau: 

 Chọn hình dạng bao nội dung text mà bạn muốn định dạng. 

 Trên tab Format, nhấn vào mũi tên trên Quick Styles (Đây là nhóm 

WordArt Styles). 

 Chọn một kiểu WordArt để ứng dụng cho nội dung text. 
 

2.2.8. Cập nhật một biểu đồ cũ 
 

 Một biểu đồ cũ bạn đã tạo trong phiên bản cũ của PowerPoint sẽ được xử lý 

như thế nào trong phiên bản PowerPoint 2007. Trong hình trên cho thấy hộp 

thoại cho bạn hai sự lựa chọn. 
 

 

 

 



  

                Tài liệu MS PowerPoint 2007 
 
 
 

 

Trang 40 

 Khi bạn lần đầu tiên mở biểu đồ bạn đã tạo ra trong PowerPoint 2003 hoặc 

phiên bản trước đây thì biểu đồ không được chỉnh sửa lại. Khi bạn nhấp đôi 

(double-click) biểu đồ thì hộp thoại Diagram Conversion xuất hiện với hai 

chọn lựa: 

 Lựa chọn đầu tiên là convert the diagram to a SmartArt graphic 

(chuyển đổi biểu đồ sang đồ họa SmartArt). Biểu đồ chuyển đổi luôn 

có sẵn cho tất cả thiết kế và công cụ định dạng của bất cứ đồ họa 

SmartArt nào. Sự chuyển hóa ứng dụng layout thích hợp, mẫu mặc 

định và màu sắc từ theme hiện tại, nhưng bạn có thể thay đổi chúng. 

Lưu ý: là lựa chọn này có thể làm thay đổi biểu đồ một cách không 

đoán trước được. 

 

 Sự lựa chọn thứ hai là convert the diagram into shapes (Chuyển đổi 

biểu đồ sang hình dạng) mà bạn có thể định dạng. Nếu bạn muốn duy 

trì nguyên vẹn biểu đồ, thì đây là sự lựa chọn của bạn. Khi bạn chọn 

convert the diagram into shapes bạn có thể chọn định dạng cho bất cứ 

hình dạng nào trong PowerPoint (những phần này thuộc về Drawing 

Tools, có thể ứng dụng cho hình dạng và placeholders, chứ nó không 

phải là một phần của SmartArt Tools. 

2.3. Công cụ trong quá trình biễu diễn 

PowerPoint cung cấp những công cụ cung cấp các chức năng rất có ích trong 

quá trình biểu diễn. Chúng ta sẽ xem xét 3 chức năng thông dụng nhất. Các 

công cụ này thể hiện qua các biểu tượng ở bên dưới màn hình. 

 

2.3.1. Sử dụng bút vẽ: 

 Sử dụng bút vẽ khi chúng ta muốn tập trung nhấn mạnh vào một số các thông 

tin nào đó trên màn hình. Để sử dụng bút vẽ: 

 Thực hiện chế độ slide show, click vào biểu tượng Pen ở bên trái, phía 

dưới màn hình. 

 Trên menu hiển thị, chọn loại bút vẽ (chẳn hạn Ball Point Pen). Con 

trỏ chuột sẽ biến đổi thành hình cây viết. 
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 Bấm chuột trái và vẽ trên màn hình(xem hình) 

 Sau khi vẽ xong, chúng ta có thể qua về trạng thái chuột ban đầu (hình 

mũi tên) bằng cách chọn biểu tượng Pen -> Arrow. 

2.3.2. Tạo ghi chú: 

Để sử dụng Speaker Notes: 

 Bấm phải chuột trên màn hình biễu diễn, Từ menu 

hiển thị, chọn Screen -> Speaker Notes. 

 Hộp thoại Speaker Notes hiển thị (xem hình). 

Nhập nội dung cần ghi nhớ và bấm nút Close để kết thúc 
việc nhập  

2.3.3. Tìm và chuyển đến một file: 

 Trong quá trình biểu diễn, đôi khi chúng ta cần nhảy đến một slide nào đó 

ngay lập tức. Cách dể dàng nhất là sử dụng chức năng Go to Slide. 

 Để sử dụng chức năng Go to Slide: 

 Trong chế độ slide show , chọn biểu tượng Menu ở bên dưới 

màn  hình -> chọn mục Go to Slide. 

 

 Một menu xuất hiện biểu diễn tất cả các slide.
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PHẦN 3.  THÊM ÂM THANH HOẶC LỜI THOẠI 

3.1. Chèn một file âm thanh 

 

 

 

 Bạn có nhiều cách để chèn thông tin trong slide của mình và sử dụng công cụ 

âm thanh trong PowerPoint để quản lý âm thanh chơi như thế nào. Bạn có thể 

sử dụng cửa sổ tác vụ Custom Animation và đưa ra những lệnh chính xác với 

PowerPoint cách bắt đầu hoặc ngừng âm thanh như thế nào. 

3.1.2. Chèn âm thanh bằng cách sử dụng tab Insert 
 

 

 Bạn có thể chèn âm thanh từ máy tính của bạn hoặc chèn âm thanh từ một file 

trên mạng nội bộ hoặc chèn một file trong thư viện clip. Những file này có tên 

như MySound.wav hoặc Atmospheric.mid. Những bước sau chỉ cho bạn cách 

chèn âm thanh bằng tab Insert. 

 Click vào tab Insert. 

 Chọn nút mũi tên trên hộp Sound. 
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 Để chọn một file âm thanh từ máy tính của bạn hoặc file từ mạng 

nội bộ, chọn Sound from File. Tìm file và nhấp đôi chuột để chèn nó 

vào slide. 

 Để chèn âm thanh từ thư viện clip, chọn Sound from Clip Organizer 

và tìm kiếm clip trong cửa sổ nhiệm vụ Clip Art. Chọn clip bạn muốn 

chèn vào slide. 

3.1.3. Chèn âm thanh bằng cách sử dụng Slide Placeholder 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Bạn có thể sử dụng những biểu tượng như hình trên để chèn vào file âm thanh. 

Kết quả cũng tương tự như bạn sử dụng tab Insert, nhưng bạn sử dụng 

content placeholder như hình trên. 

1. Click vào biểu tượng Insert Media Clip để tìm file âm thanh trên máy 

tính hoặc trên mạng nội bộ. 

2. Click vào biểu tượng Clip Art để mở cửa sổ nhiệm vụ Clip Art để file 

âm thanh chèn vào clip. 

3.1.4. Bắt đầu chơi âm thanh 
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 Trong quá trình chèn âm thanh, một cửa sổ nhỏ hiện ra với hai sựa lựa chọn là 

bạn  muốn âm thanh sẽ bắt đầu một cách tự động hay bạn muốn bắt đầu âm 

thanh bằng cách click chuột. Chọn Automatically nếu bạn muốn âm thanh tự 

động chơi khi slide được thuyết trình. Nếu trong slide đã có các hiệu ứng khác 

như âm thanh, đoạn video clip, thì âm thanh sẽ bắt đầu chơi khi các hiệu ứng 

đã có kết thúc. 

 Chọn When Clicked nếu bạn muốn âm thanh bắt đầu chơi khi bạn nhấn vào 

biểu tượng trên slide. 

3.1.5. Chơi âm thanh trên Slide 

 

 

 Âm thanh đã chèn trên slide và mặc dù bạn chọn cách chơi tự động hay chọn 

cách nhấp chuột vào biểu tượng âm thanh, thì âm thanh sẽ chơi từ đầu đến 

cuối bài thuyết trình, trừ khi bạn click trên slide để ngừng âm thanh. Bạn có 

thể chơi âm thanh từ đầu đến cuối bằng cách: 

 Chọn biểu tượng âm thanh. 

 Trên Ribbon, dưới Sound Tools, chọn tab Options. 

 Trong nhóm Sound Options, trong danh sách Play Sound, chọn Play 

across slides. 

 Đây là cách bắt đầu âm thanh một cách tự động khi slide bắt đầu thuyết trình 

và nó sẽ không ngừng mặc dù bạn có click chuột lên slide. Nó sẽ ngừng khi 

kết thúc đoạn âm thanh hoặc bài thuyết trình kết thúc. Nếu bạn muốn nó 

ngừng như thế nào thì sử dụng trình nhiệm vụ Custom Animation. 
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3.1.6. Thiết lập thời gian cho âm thanh ngừng 
 

 

 
 

Bạn có thể chọn cách ngừng âm thanh trong bài thuyết trình bằng cửa sổ 

nhiệm vụ Custom Animation. Với một file phim ảnh bạn cũng sử dụng cửa 

sổ nhiệm vụ này. Để làm cho âm thanh chơi, nhưng ngừng trong một số slide, 

đầu tiên mở cửa sổ nhiệm vụ Custom Animation trong tab Animation và sau 

đó làm như sau: 

 Âm thanh trong bài thuyết trình có hiệu ứng bởi tên của nó trong cửa 

sổ nhiệm vụ, ví dụ trong hình trên tên của nó là LongerFlute.wav. khi 

hiệu ứng được chọn trên slide, thì nó cũng được chọn trên cửa sổ 

nhiệm vụ. 

 Click vào mũi tên trong hộp hiệu ứng âm thanh để thể hiện nó trên 

menu. 

 Trên menu, chọn Effect Options. 

 Trong hộp thoại Play Sound, bạn có một vài lựa chọn cách ngừng âm 

thanh như thế nào. Để xác định ngừng âm thanh sau một số slide thì 

chọn mũi tên trong hộp After. Trong hình trên, thì âm thanh sẽ chơi chỉ 

trong 3 slide. 
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3.1.7. Thay đổi cách âm thanh bắt đầu 
 

 

Bạn cũng sử dụng Custom Animation để thiết lập chế độ âm thanh bắt đầu 

như thế nào trong bài thuyết trình. Chẳng hạn bạn đã chọn âm thanh bắt đầu tự 

động, nhưng sau đó lại quyết định nó nên bắt đầu bằng cách click chuột. Cách 

làm như sau: 

 Nếu âm thanh bắt đầu tự động thì bạn sẽ thấy giống như hình trên, 

trong hộp Start hiện ra một chiếc đồng hồ với dòng chữ After 

Previous. 

 Chọn mũi tên trong hộp Start và chọn Start On Click. 

 Hiệu ứng đã được thay đổi bằng biểu tượng con chuột trong hộp Start, 

bạn có thể click chuột để bắt đầu âm thanh. 

3.1.8. Cài đặt phương thức kích hoạt (trigger) âm thanh trên slide 

Bạn đã biết một số cách bắt đầu âm thanh trong slide và đây là một cách thay 

đổi vui vui là thay đổi biểu tượng âm thanh (trigger). 
 

 

 
 

1. Biểu tượng âm thanh được chèn vào slide. 

2. Trong cửa sổ tác vụ Custom Animation, chọn nút mũi tên trong 
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Sound Effect và sau đó chọn Timing trên trình đơn. 

3. Trong hộp thoại Play Sound, dưới Triggers, chọn Start effect on 

click of. 

4. Chọn mũi tên và chọn biểu tượng âm thanh khác thay thế cho cái loa. 

Ví dụ bạn chọn Right Arrow 6. 

3.1.9. File âm thanh của bạn liên kết hay được nhúng 
 

 

 

 

1. Những file này sẽ kết nối đến bài thuyết trình bởi vì nó không 

phải là file .wav hoặc có dung lượng lớn hơn 100KB. 

2. Những file này được nhúng trong bài thuyết trình bởi vì chúng là 

file .wav và có dung lượng dưới 100KB. 

Để đảm bảo âm thanh sẽ được chơi trong bài thuyết trình của bạn thì hãy quan 

tâm đến chi tiết về dung lượng của file âm thanh. Mặc dù file âm thanh được 

kết nối đến bài thuyết trình bằng cách kết nối hay được nhúng. Nhưng điều 

quan trọng hơn là hãy quan tâm PowerPoint có thể tìm thấy file âm thanh mà 

bài thuyết trình có liên kết đến. 

 Những file liên kết 

Một file liên kết thực sự không phải là nội dung của bài thuyết trình, 

thay vào đó PowerPoint tạo ra một đường liên kết đến file này bằng 

cách chèn nó vào trong bài thuyết trình. Ví dụ file này có thể ở trên 

máy tính hoặc trên mạng nội bộ mà máy tính của bạn có thể liên kết 

được. Chính vì vậy, khi bạn chèn nó thì thực sự bạn đã tạo được 

đường liên kết đến nó. PowerPoint dựa trên đường liên kết này để 

chơi âm thanh. Khi bạn di đời hoặc xóa bỏ file âm thanh này, thì 
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đường liên kết không còn hiện hữu, vì vậy bài thuyết trình sẽ không 

có âm thanh, vì PowerPoint không tìm thấy file âm thanh này. 

 Những file nhúng 

Một file nhúng là một phần của bài thuyết trình. Nếu bạn muốn sao 

chép bài thuyết trình đến một vị trí khác trên máy tính thì file âm thanh 

vẫn chơi được trên bài thuyết trình. 

3.1.10. Làm thế nào để thực hiện các file liên kết 
 

 

 
 

Dưới đây là hai bài thực hành để liên kết file âm thanh đến bài thuyết trình: 

 Bài thực hành thứ 1: Khi bạn tạo ra một bài thuyết trình và trước khi 

chèn file âm thanh, nên copy file âm thanh vào cùng một folder. Sau đó 

chèn nó vào bài thuyết trình, PowerPoint sẽ tạo ra đường liên kết với 

file âm thanh trong folder có chứa cả file thuyết trình và file âm thanh. 

Khi bạn di chuyển hoặc sao chép folder đó đến một máy tính khác, thì 

âm thanh vẫn được chơi trong bài thuyết trình. 
 

 Bài thực hành thứ 2: Khi bài thuyết trình đã được làm xong và bạn 

muốn sao chép nó thì nên sử dụng Package for CD. Chức năng này sao 

chép tất cả các file đến một vị trí trên CD hoặc một folder nào đó và nó 

tự động cập nhật những đường liên kết cho file âm thanh, hình ảnh. 
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3.2. Chơi âm thanh từ đĩa CD 
 

 

 Chơi âm thanh từ đĩa CD cho bài thuyết trình cho bạn một sự lựa chọn âm 

thanh nền khác đa dạng hơn. Bạn có thể chọn đường dẫn để chơi âm thanh 

trong suốt bài bài thuyết trình hoặc thiết lập chế độ bắt đầu và kết thúc cho file 

âm thanh. Với cách này thì không ảnh hưởng đến dung lượng của bài thuyết 

trình, nhưng một điều đáng lưu ý là bạn phải luôn mang theo đĩa CD khi bạn 

thuyết trình. 

 Thiết lập đường dẫn cho CD 
 

 

 
1. Trên tab Insert, trong nhóm Media Clips, chọn mũi tên trong hộp 

Sound và chọn Play CD Audio Track. 

2. Kế bên hộp Start at track, chọn track (bài hát hay âm thanh theo 

thứ tự). 

3. Trong hộp time, xác định thời gian CD bắt đầu chơi. Nếu thời 

gian là 00:00 có nghĩa là âm thanh sẽ được chơi khi bài thuyết trình 

bắt đầu. 
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4. Kế bên hộp End at track, chọn track bạn muốn kết thúc. Bạn cũng 

có thể kết thúc với track bắt đầu 

5. Trong hộp time, xác định thời gian track ngừng. Để chơi tất cả các 

track, chọn chơi hết thời gian. Lưu ý khi bài thuyết trình kết thúc 

trước, thì âm thanh cũng ngừng theo. 

PHẦN 4.  ĐỊNH DẠNG BÀI THUYẾT TRÌNH 

4.1. Cá nhân hóa định dạng bài thuyết trình 

4.1.1. Chọn theme để phục vụ cho định dạng thuyết trình của bạn 

 Giả sử rằng bạn làm việc cho Công ty du lịch Margie và công ty đang có chiến 

dịch mở rộng tour đến các nước nhiệt đới và và bạn muốn làm một bài thuyết 

trình nổi bật bằng cách tạo ra slide có một phong cách đặc biệt. Cách nhanh 

nhất để làm được điều này là bạn có thể sử dụng chức năng theme. 
 
 
 

 

 Theme có thể dễ dàng tạo ra bài thuyết trình chuyên nghiệp nhưng tốn ít thời 

gian cho từng phần trong slide như nền, nội dung text, bảng biểu và hình 

dạng. Chỉ với một vài cái click chuột đơn giản, bạn có thể thay đổi bài thuyết 

trình một cách nhanh chóng. Trong ba slide ở hình trên cho thấy màu sắc được 

thay đổi rất dễ nhận thấy được. Nhưng nếu bạn nhìn kỹ phía bên trái slide, thì 

tiêu đề placeholder xuất hiện ở phía dưới slide, mặc dù ba slide đều sử dụng 

cùng một layout Title and Content. 

 Nếu bạn đã từng sử dụng PowerPoint 2003 hoặc phiên bản trước đây, có thể 

bạn đã quen sử dụng với thiết kế template. Nhưng với PowerPoint 2007, thiết 

kế template đã được thay thế bằng chức năng theme linh hoạt hơn. 
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4.1.2. Các thành phần của một theme 

 Theme thật sự quan trọng để tạo ra sự khác biệt trong cuộc cạnh tranh, chính 

vì vậy bạn không muốn bài thuyết trình cho tour du lịch đến các nước nhiệt 

đới giống như bất cứ một bài thuyết trình của các công ty khác. Thay đổi và 

tùy biến theme có thể làm cho bài thuyết trình của bạn dễ nhớ và ấn tượng 

hơn. 

 

 

 Theme là sự kết hợp bao gồm màu sắc, font chữ, hiệu ứng, hình nền được ứng 

dụng cho một hay nhiều slide hoặc toàn bộ bài thuyết trình. Theme nằm ở 

trong thư viện Themes trên tab Design. Khi chỉ con trỏ một lúc vào một mẫu 

theme trong thư viện, bạn có thể xem qua theme mà bạn muốn sử dụng cho 

bài thuyết trình, chức năng này được gọi là Live Preview (xem thử trực tiếp). 

4.1.3. Thay đổi hoặc tùy biến theme 

 Chọn Colors, Fonts, hoặc Effects để thay đổi hoặc tùy biến các yếu tố của 

theme 
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 Một cách khác để làm cho bài thuyết trình của bạn ấn tượng hơn các bài 

thuyết trình của công ty du lịch khác là thay đổi hoặc tùy biến theme bằng 

cách sử dụng chức năng tùy biến trên tab 

 Bạn cũng có thể thay đổi theme bằng cách sử dụng sự kết hợp gắn liền của 

màu sắc, font chữ và hiệu ứng hoặc tùy biến theme bằng cách tạo ra một sự 

kết hợp mới để sau này bạn có thể sử dụng theme riêng của mình. 

4.1.4. Tùy biến màu sắc theme 
 

 

 Slide sử dụng theme Flow. 

 Cùng một slide nhưng được tùy biến màu sắc. 

 Chọn nút Colors, thư viện Theme Colors xuất hiện với tùy chỉnh màu sắc từ 

các theme. Để tạo ra một màu sắc riêng, chọn Create New Theme Colors ở 

phần dưới của thư viện Theme Colors. 

4.1.5. Thay đổi màu nền của slide 
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 Theme với tên gọi Flow với màu nền mặc định. 

 Kiểu màu nền có màu sắc đồng nhất. 

 Hình nền của bề mặt gỗ 

Sau khi tùy biến màu sắc, thì cũng nên thêm màu nền cho slide. Thực ra, tất cả 

slide đều có màu nền, còn slide mặc định có màu nền là màu trắng. Để thay đổi 

màu nền, chọn nút Background Styles trên tab Design. Kiểu nền được xác định bởi 

theme, khi theme thay đổi, thì mẫu màu nền trong thư viện cũng thay đổi. 

4.1.6. Sử dụng một hình ảnh làm hình nền cho slide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bạn cũng có thể chọn một hình ảnh nào đó để làm hình nền cho bài thuyết trình 

của bạn thay vì chỉ sử dụng màu nền. 

 Có một số tab và cửa sổ nhiệm vụ cho hộp thoại Format Background, 

chuyển qua cửa sổ nhiệm vụ để thay đổi lựa chọn. 

 Để sử dụng một hình ảnh là hình nền thì chọn chức năng này. 

 Để chèn một hình ảnh từ một file, chọn File và sau đó đặt hình ảnh và xác 

định vị trí hình ảnh bạn muốn thêm vào. Để dán một hình ảnh từ Clipboard 

hoặc chương trình nào khác, thì sao chép một hình ảnh, sau đó chọn 

Clipboard. Để sử dụng clip art, thì chọn Clip Art và sau đó nhập nội dung 

mô tả clip trên hộp Search text. 
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4.1.7. Làm mờ ảnh nền của slide 
 

 
 

1. Slide với hình nền gốc. 

2. Slide sau khi sử dụng chức năng Washout (làm mờ). 

Để thay đổi sự rực rỡ hay sự tương phản của một tấm hình, bạn sử dụng tùy chọn 

trong cửa sổ Picture trên hộp thoại Format Background. Click vào Recolor để 

mở thư viện, nơi mà bạn có thể áp dụng một hiệu ứng stylized như làm mờ một 

tấm hình và sau đó under Color Modes, click Washout. 
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4.1.8. Lưu trữ file với một theme mới 
 

 

 
 

1. Chọn mút More để mở thư viện Theme. 

2. Mở hộp thoại Save Current Theme, nơi bạn có thể lưu trữ theme 

của bạn. 

3. Những Theme bạn đã tùy biến và lưu trữ xuất hiện tại nơi này. 

4.2. Khám phá sức mạnh của Custom layout 

4.2.1. Sức mạnh của layout 

 

 
 

Những layout có sẵn trong thư viện trông có vẻ tốt, nhưng chúng không hẳn là 

những layout bạn muốn sử dụng. Chính vì bạn muốn có một bài thuyết trình ấn 

tượng trước sếp của bạn hay khách hàng. Bạn có thể thêm hình ảnh, logo của công 

ty bạn để tạo ra sự khác biệt với những bài thuyết trình khác. Chính vì vậy, bạn 

hãy tận dụng sức mạnh của layout để tạo nét riêng của mình. 
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4.2.2. Layouts và Placeholders 

 

 
 

1. Title placeholder (vùng chứa tiêu đề) và Subtitle placeholders (vùng 

chứa tiêu đề phụ) 

2. Nội dung text placeholder với placeholder được chọn.  

3. Nội dung placeholder được sử dụng cho nội dung text và nội dung 

slide như clip art, SmartArt graphics, tables, shapes, pictures và đồ 

thị. 

4. Header and footer (Ngày, chân trang, số thứ tự slide) placeholders 
 

4.2.3. Xem lại Sile Master 
 

 
 
 

Cùng một side nhưng ở chế độ Normal view và Slide Master view. Để mở Slide 

Master view, trên tab View, trong nhóm Presentation Views, chọn Slide Master. 
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4.2.4. Tạo ra một custom layout 

 

 
 

 

Để thêm một custom layout: 

1. Chọn Insert Layout. 

2. Chèn mới một custom layout có bốn placeholder bao gồm một 

placeholder cho Title và ba placeholder Footers cho Ngày, Chân 

trang và Số thứ tự slide. Bạn cũng có thể xóa những placeholder 

này trong nhóm Master Layout trên tab Slide Master. 

3. Để dễ dàng sử dụng lại custom layout sau này, chọn nút Rename, 

nhập một cái tên để bạn dễ dàng nhớ trong hộp Layout name trong 

hộp thoại Rename Layout và sau đó chọn Rename. 

4.2.5. Sử dụng custom layout của bạn 

 

 
 

1. Trong slide thứ hai trong bài thuyết trình trước khi thêm layout. 

2. Custom layout được chèn sau slide thứ hai. 
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Để chèn một custom layout trên tab Slide Master, trong nhóm Close, chọn Close 

Master View. Cách dễ nhất để thêm custom layout vào bài thuyết trình của bạn là 

trên tab Home, trong nhóm Slides, chọn New Slide và sau đó chọn Tropical 

vacation layout. 

4.2.6. Lưu trữ một template 

Để lưu trữ bài thuyết trình như một file template, ta làm như sau: 

1. Chọn nút Microsoft Office  , chỉ vào Save As và sau đó chọn 

Other Formats. 

2. Trong hộp File name, nhập tên file. 

3. Trong danh sách Save as type, chọn PowerPoint Template 

(*.potx) và sau đó chọn Save. 

Template xuất hiện tại My Templates trong thư viện New Presentation khi được 

lưu trữ vào một vị trí mặc định. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

                Tài liệu MS PowerPoint 2007 
 
 
 

 

Trang 59 

PHẦN 5.  CHUẨN BỊ THUYẾT TRÌNH 

5.1. Bảo vệ, in ấn và chuẩn bị sẵn sàng cho bài thuyết trình 

5.1.1. Kiểm chứng, in ấn và chuẩn bị thuyết trình 
 

 
 

 Bạn đã biết cách tạo ra các slide cho bài thuyết trình và bạn phải chuẩn bị cho 

bài thuyết trình trước công ty. Hãy bắt đầu xem lại bài thuyết trình trên máy 

tính của bạn, kiểm tra chính tả, kiểm tra ghi chú. Sử dụng chế độ xem trước 

khi in để xem bản in như thế nào và chọn chế độ in ấn cho phù hợp. 

 Khi mọi thứ đã chuẩn bị, chuyển bài thuyết trình của bạn qua CD hay trên một 

máy tính nào đó để bạn có thể truy cập cho buổi thuyết trình. Chức năng 

packaging sẽ giúp bạn làm điều này. 

5.1.2. Duyệt lại trên máy tính 

Khi đã có một bài thuyết trình bạn có thể xem lại nó bất kỳ thời điểm nào 

bằng chức năng Slide Show view. 
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 Để mở chức năng Slide Show view, chọn tab Slide Show và chọn lệnh trong 

nhóm 

 Start Slide Show để bắt đầu slide đầu tiên hay slide hiện tại. 

 Chức năng Slide Show view sẽ phủ toàn bộ màn hình máy tính. 

 Muốn chuyển từ slide này đến slide khác là sử dụng thanh công cụ Slide 

Show ở bên trái phía dưới màn hình. Mũi tên chỉ dẫn xuất hiện khi bạn rê con 

trỏ đến khu vực này. Một cách khác để chuyển từ slide này đến slide khác là 

bằng cách click con chuột. 
 

 

 Để thoát khỏi chế độ Slide Show ở bất thời điểm nào thì bạn nhấn phím ESC 

trên bàn phím, nó sẽ trở về chế độ Normal. Ở chế độ này bạn có thể điều 

chỉnh những thay đổi cần thiết. 

 Cách khác để chuyển sang chế độ thuyết trình Slide Show là nhấn phím F5 để 

bắt đầu từ slide đầu tiên hoặc nhấn tổ hợp phím Shift + F5 để bắt đầu thuyết 

trình từ slide hiện tại, hoặc bạn có thể click vào nút Slide Show ở bên phải 

dưới màn hình. 
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5.1.3. Kiểm tra ngữ pháp và những bình luận (comment) trên slide 

 Bạn muốn lại trừ bất cứ lỗi chính tả nào hoặc tìm những cái sai ngớ ngẩn 

trước khi thuyết trình, hãy chọn tab Review để thực hiện kiểm tra chính tả, 

nhưng nên nhớ rằng chưa có công cụ kiểm tra lỗi chính tả cho tiếng Việt. Đây 

cũng là nơi xem bình luận của người khác họ xem slide của bạn. 
 

 

 Trên tab Review, trong nhóm Proofing, click Spelling. 

 Bạn cũng có thế muốn người khác xem qua bài thuyết trình của bạn và cho 

bình luận trước khi bạn thuyết trình. Tìm lệnh New Comment, trong nhóm 

Comments, trên tab Review. Một người thêm bình luận chỉ việc click vào 

lệnh và nhập bình luận của mình cho từng slide. Khi xem lại những bình luận 

này, bạn sử dụng Previous và Next trong nhóm Comments. 

5.1.4. In ấn tài liệu 

 Chương trình in của PowerPoint printout ra thường được gọi là handout. 

Handout có thể có một hay nhiều slide trong một trang, nhiều nhất là 9 slide. 
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 Cách tốt nhất là dùng lệnh Print Preview để chọn kiểu handout trước khi 

in ấn. Bắt đầu bằng cách click Print Preview trên nút Microsoft Office. 

 Trong Print Preview, chọn mũi tên trong hộp Print What. 

 Chọn một kiểu handout trong danh sách. 

 Chỉ con chuột vào kiểu handout nào, thì kiểu này phóng to cho bạn xem định 

dạng này. Đối với những định dạng có 3 slide thì có cả phần ghi chú. 

5.1.5. In ấn ghi chú 

 

 Bạn đã in tài liệu cho người tham gia buổi thuyết trình và bạn muốn in ấn 

thêm ghi chú cho chính mình để thuận tiện diễn đạt trong khi thuyết trình. 

Cũng bằng cách chọn Print Preview trên nút Microsoft Office. 

 Để in ghi chú người diễn thuyết, chọn Notes Pages trong hộp Print What. 

 Ghi chú của bạn được hiển thị trên màn hình. 

5.1.6. Thêm nội dung footer trong tài liệu handout và tài liệu notes 

 

 
Print Preview cũng cho phép bạn thêm hoặc điều chỉnh footer trong tài liệu 

handout hoặc tài liệu note. Mặc định thì tài liệu in ấn handout và tài liệu note 

đã có sẵn số trang. Nếu bạn muốn muốn thay đổi chúng bằng một đoạn text 

thì làm những bước sau: 
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1. Chọn Options và sau đó nhấn Header and Footer. 

2. Chọn  Footer  và  sau  đó  nhập  đoạn  text  bạn  muốn  thêm  vào  

ví  dụ  như "Confidential". Nếu bạn muốn thêm ngày giờ thì chọn 

Date and time và sau đó định dạng ngày giờ trong hộp thoại. 

5.1.7. Chọn màu sắc để in ấn 

 

 
 

Tùy thuộc vào máy in, nên bạn có thể in ấn bài thuyết trình có màu sắc hoặc trắng 

đen. Sau đây là cách in ấn: 

1. Dưới Print Preview, chọn Options và chỉ đến Color/Grayscale, 

sau đó chọn lựa. Nếu bạn trong máy in đen trắng, thì mặc dù bạn đã 

chọn màu thì kết quả ra vẫn là màu đen trắng. 

2. Mẫu xem lại của tài liệu in màu 

3. Mẫu xem lại của liệu in ấn màu xám, màu nền là màu trắng. 

4. Mẫu xem lại của tài liệu in trắng đen. 

5.1.8. Sao chép đến CD 
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Bạn muốn sao chép một file trực tiếp đến một đĩa CD. Nếu bạn sao chép tài liệu 

đến một folder thì bạn có thể burn vào CD, bạn cũng có thể copy file đến mạng 

nội bộ để truy cập từ máy tính của mình. Để đóng gói bài thuyết trình của bạn: 

1. Click vào nút Microsoft Office     

2. Chỉ đến Publish và chọn Package for CD. 

3. Trong hộp thoại mở ra, chọn gói tin sao chép đến một file khác hay 

sao chép đến CD. 

PHẦN 6.  CÁC THỦ THUẬT TRONG MS OFFICE POWERPOINT 

6.1. Thay đổi Theme một cách nhanh chóng: 

Nếu bạn tự tạo một bản trình chiếu từ một theme có sẵn và sử dụng các 

Style đã có trong theme, thì việc thay đổi một giao diện hoàn toàn khác cực 

kỳ đơn giản. Chỉ cần chọn lại theme trong danh sách sẵn có nằm trên tab 

Design. 

6.2. Sử dụng các font phổ biến  
Để tránh những vấn đề phức tạp khi chuyển một file PowerPoint từ máy 

tính này sang máy tính khác, bạn hãy sử dụng các font như Arial, Verdana, 

hoặc Times New Roman. Các máy tính với các phiên bản Office cũ không 

phải lúc nào cũng luôn có các font mặc định của PowerPoint 2007 (Ví dụ 

như Calibri, Corbel,…) 

6.3. Giữ các layout cho riêng mình  
Nếu bạn muốn giữa một số slide layout cho bản thân mình, hãy tạo một tập 

con cho chúng để sử dụng bằng cách chọn View | Slide Master và từ danh 

sách slide layout ở phần bên trái màn hình xóa các layout không có khả 

năng sử dụng trong trình diễn này. 
 

6.4. Giữ các layout cho riêng mình  

Nếu bạn muốn giữa một số slide layout cho bản thân mình, hãy tạo một tập 

con cho chúng để sử dụng bằng cách chọn View | Slide Master và từ danh 

sách slide layout ở phần bên trái màn hình xóa các layout không có khả 

năng sử dụng trong trình diễn này.  
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6.5. Nhúng các font để soạn thảo được dễ dàng  
Khi chuyển một file trình chiếu sang một máy tính khác để chỉnh sửa, hãy 

nhúng các font bên trong trình chiếu để chúng sẽ có khi bạn tạo các thay 

đổi. Để thực hiện điều này, bạn hãy chọn File | Save As, chọn Tools | Save 

Options và kích hộp kiểm “Embed fonts in the file”. 

 

6.6. Để lại comment cho các đồng nghiệp  

 

Nếu bạn đang cùng làm việc với các đồng nghiệp trên cùng một trình chiếu 

slide và cần truyền thông với ai đó, hoặc nếu bạn cần nhắc nhở chính bản 

thân mình về thứ gì đó, hãy sử dụng comment. Chọn Reviewing | New 

Comment và đánh vào comment của bạn trước khi kéo nó vào vị trí trên 

slide. 

Thêm tùy chỉnh ảnh: Các ảnh chèn vào có thể được tạo shadows, các thù 

hình, kiểu dáng và hiệu ứng mới, bên cạnh đó còn có thể được crop (cắt 

viền ảnh) khi cần. Trên tab Insert, kích Picture để thêm vào một ảnh. Chọn 

nó và tab Format lúc đó sẽ có sẵn, ở đây bạn có thể thử nghiệm với Picture 

Styles hoặc chọn các kiểu tùy chỉnh. 

 

6.7. Cách điệu hóa các bảng dữ liệu  

Các bảng dữ liệu có sẵn kiểu trong PowerPoint 2007. Chọn bất cứ bảng nào 

và vào tab Table Tools (được gọi là Design and Layout) xuất hiện trên 

ribbon. Kích Design để nhập vào các kiểu cho Table Styles. Tạo những sản 

phẩm của riêng bạn theo các điều khiển trên tab đó. 

 

6.8. Nén ảnh  

Các ảnh đã được chèn có thể được nén riêng để giảm kích thước của toàn bộ 

file PowerPoint, phụ thuộc vào cách nó sẽ được hiển thị như thế nào. Trong 

tab Format có sẵn khi bạn chọn một ảnh nào đó, kích Compress Pictures.  

6.9. Chèn biểu đồ powerpoint  

Các biểu đồ không đơn giản là cho Excel nữa. Tab Insert của PowerPoint 

2007 có một biểu tượng Chart, ở đây bạn có thể chọn Line, Bar, Pie, Area, 

và Surface để bắt đầu. Nó sẽ tự động mở Excel và hiển thị cho bạn dữ liệu 

mẫu mà bạn có thể tùy chỉnh. Khi thay đổi xong, hãy kích trỏ về 

PowerPoint để cập nhật tức thì. 
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6.10.  Tạo mẫu trình chiếu  
Đổi bất kỳ một trình chiếu PowerPoint nào thành một mẫu để sử dụng lại 

khi cần bằng cách remove các slide không cần thiết hoặc cung cấp thông tin 

từ nó. Chọn Save As, sau đó Other Formats, và chọn tùy chọn 

PowerPoint Template (*.potx) từ danh sách kiểu lưu trữ để lưu mẫu tùy 

chỉnh.  

6.11.  Sử dụng Excel để định dạng các biểu đồ  

Để sử dụng một mẫu biểu đồ nhằm mục đích định dạng biểu đồ cho 

PowerPoint, kích vào đối tượng biểu đồ trong trình chiếu để chọn nó. Chọn 

Chart Tools | Design | Change Chart Type, kích vào tùy chọn Templates 

và chọn mẫu được lưu từ danh sách.  

6.12.  Nhóm và lưu để sử dụng lại  
Có thể lưu một thành phần hoặc một nhóm các thành phần mà bạn có trên 

slide PowerPoint thành một picture để sử dụng lại trong một trình diễn khác 

hoặc ứng dụng khác. Để thực hiện, hãy chọn đối tượng, kích chuột phải vào 

nó và chọn Save As Picture. Chọn định dạng đồ họa và vị trí lưu, đánh tên 

file, cuối cùng là kích OK.  

6.13.  Canh lề cho các đối tượng trên một slide  
Để canh lề nhiều đối tượng trong một slide PowerPoint, kích vào đối tượng 

đầu tiên và giữ Ctrl kích vào mỗi đối tượng bổ sung một cách lần lượt. 

Chọn Drawing Tools | Format và kích nút Align. Từ menu, bạn hãy chọn 

tùy chọn như Align Left, Align Right, Align Top, hoặc Align Bottom. 

6.14.  Sử dụng khung lưới cho layout  

Có thể hiển thị khung lưới layout cho việc gióng các đối tượng trên các slide 

bằng cách chọn View | Gridlines. Để cấu hình các đường gridlines, bạn hãy 

vào Tools | Format | Align và chọn Grid Settings.  

6.15.  Hiện thước kẻ  
Để điều chỉnh chữ lùi vào cho mỗi một đoạn riêng trên slide PowerPoint, 

trước tiên bạn cần hiện các thước đo bằng cách chọn View | Ruler. Chọn 

các đoạn để thay đổi và kéo các điểm thước First Line Indent và Left Indent 

trên thước để thay đổi. 
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6.16.  Tạo nút action  
Sử dụng một nút action để liên kết với slide thông tin hoặc trợ giúp. Chọn 

Insert | Shapes và từ nhóm Action Button chọn Action Button: 

Information hoặc Action Button: Help. Kéo nút này trên slide, từ 

Hyperlink của hộp thoại đến danh sách, chọn slide để liên kết đến.  

6.17.  Chèn các background chung  
Để bổ sung thêm background cho tất cả các slide, hãy chọn View | Slide 

Master và chọn slide chủ. Kích vào bộ marker để mở nhóm Background và 

hiển thị hộp thoại Format Background. Chọn Picture, kích nút File, chọn 

ảnh và kích Close. 

6.18.  Tạo nhiều cột văn bản  
Để tạo nhiều cột của một văn bản bên trong PowerPoint, hãy chọn văn bản 

và từ nhóm Paragraph của tab Home, hãy kích nút Columns. Chọn số cột 

để sử dụng cho văn bản. Thao tác này cũng làm việc cho văn bản đã được 

đặt bên trong các hình hay các hộp văn bản.  

6.19.  Tùy chỉnh hình vẽ  
Để chuyển một hình vẽ có sẵn (vuông, tròn…) sang một hình có thể tùy 

chỉnh bằng chuột, hãy chọn nó và kích vào Drawing Tools | Format. Từ 

nhóm Insert shapes, kích nút Edit Shape và chọn Convert to Freeform. 

Chọn Edit Points khi đó bạn có thể thay đổi hình bằng cách bổ sung thêm 

các nút, xóa hoặc kéo hình để tạo các đường khác.  

6.20.  Xem và sửa trình chiếu  

Để hiển thị một trình chiếu trên màn hình khi bạn làm việc, hãy kích tab 

View và giữ phím Ctrl khi bạn kích nút Slideshow. Thao tác này sẽ hiển thị 

trình chiếu trong phần trên bên trái của màn hình, cho phép bạn chuyển giữa 

việc xem trình chiếu và soạn thảo nó.  

6.21.  Sử dụng chế độ Kiosk để tự động chạy  
Để chạy một trình chiếu tự động, hãy chọn tất cả slide trong thumbnail 

pane; chọn Animations, thiết lập Automatically với thời gian chuyển thích 

hợp. Chọn Slide Show | Set Up Show, chọn Browsed at a Kiosk (full 

screen), và trong phần Advance slides, chọn Using timings nếu có xuất 

hiện.  
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6.22.  Tạo SmartArt từ những thứ có sẵn  

Chỉ có trong PowerPoint 2007 bạn mới có thể tạo đối tượng SmartArt từ 

văn bản tồn tại. Để thực hiện, bạn hãy chọn văn bản và từ tab Home, nhóm 

Paragraph, chọn nút Convert to SmartArt Graphic và chọn kiểu 

SmartArt.  

6.23.  HACK: Không sử dụng tất cả slide của bạn 
Nếu bạn có một trình chiếu có đến hàng tấn slide nhưng chỉ có một nhóm 

phù hợp với thính giả hiện tại, không nên lãng phí thời gian bằng cách cuộn 

qua tất cả các slide. Trên tab Slide Show, kích Custom Slide Show, chọn 

các slide cần thiết, kích Show để khởi chạy trình chiếu đã được lược bớt.  

6.24.  Tab Developer  
Tab Developer được yêu cầu để thực hiện những thứ như bổ sung thêm như 

các file Flash vào một trình chiếu và chạy các macro. Để cấu hình xuất hiện 

trên ribbon, bạn hãy kích nút Microsoft Office, chọn PowerPoint Options | 

Popular, và kích tab Show Developer trong hộp kiểm Ribbon. Kích OK.  

6.25.  Chèn Flash vào trong các trình chiếu  
Để trình chiếu file Flash, kích tab Developer, trong phần Controls, kích 

More Controls, và chọn Shockwave Flash Object. Kích chuột trái và kéo 

trên slide để tạo một hình chữ nhật vào nơi bạn muốn bổ sung thêm điều 

khiển; kích chuột phải vào nó, chọn Properties và thiết lập thuộc tính 

Movie với đường dẫn đầy đủ của file Flash.  


